
Welcome to Navaho Lock with Voice ä Help

Choose one of the topics on the left to find the information you are looking for. You can also use the 
Index to look-up words or use the Help Search feature to quickly find the information you are looking 
for.
Whenever you see underlined words such as Welcome, click on it to jump to that topic (in this case, the
same topic).
When you see the word More or another word underlined with dashes in this way, clicking on it will 
produce a popup text box with additional information on that item.



First Step - User Profile and Logging On

Navaho Lock with Voiceä is used to send encrypted text, graphic and voice files over the Internet. 
Many of the features of this security program are designed to prevent unauthorized access to your 
files.    

User Profile
When the program is first installed, no user accounts are set up. The New User Wizard will help you 
open a New User account so that you can create your Address Book and send or open encrypted files.

1. Account Name 

 
Enter your user name in the area provided. This will be the name assigned to your account and your 
Address Book.

2. Full Name and Email

 
Enter your full name and email address in the areas provided. Recipients of your email messages will see
this name associated with your messages.

3. Phone Number



 
This section is optional. If you wish to have recipients call you to exchange passwords via telephone 
insert your phone number here. The phone number will be attached to your messages in an unencrypted 
state.

4. Encryption Provider and Algorithm

 
To change the cryptographic service provider, select from the pull-down menu (either Microsoft&R& Base 
Cryptographic Provider or Microsoft Enhanced Cryptographic Provider). Please note if you send someone
a message encrypted with an algorithm from the Enhanced Provider and they only have the Base 
Provider, they will be unable to open your message.
Once you have selected the cryptographic provider, a list of algorithms will appear in the Encryption 
Algorithm box below. Select the algorithm you want as your default.

5. Password



 
Enter the password you will use to log on. Re-enter the password to verify it.
NOTE: This is the only password you need to remember to get into Navaho Lock with Voice    &TM& and 
send, receive and store files. *REMEMBER IT*.

Logon
Now that your account and password are set up, you can log on by either: 

1. Clicking on the Logon icon on the toolbar, or 
2. Clicking on the Actions menu, and then clicking on Logon.

Go to Step 2 



Second Step - Creating your Voice Message

1. You will require an external microphone to record a voice message. Make sure that it is properly 
connected to your computer before proceeding.

2. Click the New button. The screen will then look like the image below.

From this main window, you can access all the functions of Navaho Lock with Voice ä to create, record, 
encrypt, open and send packages.    To record your voice message, click on the Plus button in the Voice 
Area. The following dialog box will appear:

Under Voice Message name, enter a name for the voice file in the space provided. File Naming
Click on the circular button in the Voice Area to begin recording your message.
Click on the square button on the right to stop recording at any time.
To listen to your message, click the triangular button in the middle for playback.
If you wish to re-record the message, click on the Cancel button.
When finished recording, click OK. You will be returned to the Navaho Lock with Voice ä main 
screen.
If you want to attach a text or graphic file to the package, go to Step 3. 
If you want to simply send the voice message, go to Step 4.



Third Step - Creating your Text Message

1. Select any files or folders that you want from Explorer. Drag them into the Drop area to attach 
them to your Navaho Lock with Voice ä package.

2 Type or paste a text message into the Message Area. Use the tabs at the bottom of the 
Message Area to enter text in the encrypted message area and/or the unencrypted message 
area.

Go to Step 4 



Fourth Step - Adding Contacts to your Address Book

The Address Book stores your email contacts and their associated passwords. For each 
correspondent, you will need to set up a secret password - either in person, over the phone, or by mail.
The password you agree on should only be used to send mail to and receive mail from this 
correspondent.

1 Pull down the Address Book menu and click on Open.

 
The Address Book expands to display fields for entering information.

2 To add a new contact record, click on the Add button at the bottom of the dialog box.

 
Enter your contact's information, including the agreed upon secret code, into the appropriate fields.



3 Click OK to save the contact and associated password. Navaho Lock with Voice ä will return 
you to your Address Book.

Go to Step 5 



Fifth Step - Sending your Package

1. When your Navaho Lock with Voice package is ready to send, press the To button in the 
Message Area. The Address Book will open so that you may choose a contact to send the 
message to. After you select a contact and press OK, Navaho Lock with Voice will return you to 
the main screen.

2. Press the Send button in the Message Area and your message will be sent.

Go to Step 6 



Sixth Step - Saving an Encrypted Copy

1)  To store an encrypted copy of the Sent message locally, click on the Save button on theToolbar 
(then select Save As).

2) A dialog box will open to allow you to choose a name and a storage location for your encrypted 
file. Navaho Lock with Voice ä defaults to save documents within sub-folders in the Navaho 
Lock folder. The file extension for Navaho Lock with Voice ä encrypted files is .nvl.

3) Type in a name for your encrypted file in the space provided. Click Save.    
Although you have now saved your encrypted file locally, you still have an unencrypted copy on your 
hard drive.
For security reasons, you may want to delete this unencrypted file later.
Go to Step 7 



Seventh Step - Opening Navaho Lock with Voice ä Encrypted Files

Received files are stored within your email program, unless you resave them to the Saved Packages 
folder.
To open a received encrypted package double click on the .nvl attachment icon in your email program.  

If you are currently logged into a Navaho Lock with Voice session, your Address Book will open with the 
appropriate contact selected (if entered in your book). Click OK and the package will open.    If the contact
is not in your Address Book, enter the contact. (see Step 4).    If you are not currently logged on, Navaho 
Lock with Voice will bring up the Logon dialog box.

If your contact sends you a message using a different email address (but using your common 
password), simply select their user name in the Address Book and click OK. The package will open.



Compress / Decompress

Navaho Lock with Voice ä can be used to compress and decompress files. Not only will this save 
space on your hard drive, but it will also reduce transmission time when sending a file electronically. 
Any text files in the Drop area and any voice files in the Voice Area are automatically compressed 
before transmission. 



Encrypt

Navaho Lock with Voice ä has the ability to encrypt messages to make them inaccessible to 
unauthorized individuals. The application does not use its own internal encryption engine. Instead, it 
accesses the strong encryption built into Windowsä operating systems for secure Internet 
communication.
For basic information on encryption, go to Encryption Basics.



Decrypt

Navaho Lock with Voice has the ability to decrypt a message that was encrypted by another Navaho 
Lock with Voice user, as long as the recipient has the password for that particular file or document.



Receiving Encrypted Messages

Incoming messages are received by your email program. To open Navaho Lock with Voiceä packages
double-click on the message attachment and Navaho Lock with Voiceä will launch.    Enter your Logon
username and password.    A second dialogue box will open up, select the name and enter the correct 
secret code and press OK.



Sending Voice Messages

Navaho Lock with Voice ä can record, compress, encrypt and playback voice messages. The features
can be found under the Voice menu or in the Voice Area.
When you send your Navaho Lock with Voiceä package, the package will automatically be 
compressed and encrypted. If you want to send the voice message unencrypted, you will have to send 
the entire package as an unencrypted transmission.
Voice Area 
Voice Menu Commands 
Sending Unencrypted Messages 



Sending Encrypted Messages

After typing your message in the encrypted message area, select the documents or files you would like
to send by dragging and dropping them from the explorer window into the Drop area, choose the 
recipient(s) and click on Send.    
Sending Unencrypted Messages 



Sending Unencrypted Messages 

The default for sending messages from Navaho Lock with Voice is encryption on.    You can, however, 
turn encryption off for any individual file or message.    Encryption can be turned off by pulling down the 
Actions menu, dragging the mouse to Encrypt, and releasing the mouse. Encryption must be turned 
off for each unencrypted message that you want to send.
Navaho Lock with Voice ä also allows you to send a portion of your text message unencrypted. Select
the Encrypted Message Area tab in the Message Area and enter the portion of your message that you 
want protected. Select the Non Encrypted Text Area tab and enter the text that you want visible.
Message Area 



Store Encrypted Data

In addition to sending messages, Navaho Lock with Voice ä has the ability to encrypt and store files 
locally, providing you with protection and privacy should someone steal your computer or access it in 
person or through the Internet.



Encryption Basics

Modern encryption takes advantage of the computer's ability to handle complex mathematics. All 
encryption schemes today use algorithms to scramble messages. Effective algorithms are extremely 
difficult to factor in reverse.
The two main types of encryption are public/private key (asymmetrical) and secret key (symmetrical). 
In public/private key encryption, a pair of keys is generated: the public key is used to encrypt the 
message and the private key is used to decrypt it. In secret key encryption, the same key is used for 
both encryption and decryption.
Navaho Lock with Voice ä encrypts messages using secret key encryption.



Algorithm Basics

The algorithm is the mathematical formula that is used to scramble your data.    Algorithms work by 
shuffling blocks of data around, much like shuffling a deck of cards.    The "key" determines the 
sequence of shuffling and allows the data to be "unshuffled" back to its original order.
One of the main factors in the strength of the encryption is key size, which is measured in bits. 
Currently, 40-bit and even 56-bit keys are considered to be breakable, but 128-bit keys or higher are 
considered to be unbreakable with today's computers. Algorithms that use double, triple, or quadruple 
encryption will further stymie attempts to crack an encrypted message. These algorithms are used two,
three or four times respectively (with a different key every time) to encrypt each message.
The MicrosoftÒ Enhanced CSP comes with several strong encryption algorithms (up to 168 bits); 
however, current export laws in the U.S. limit messages to Europe and Asia to 56-bit encryption.
Cryptographic Service Providers 



MS Cryptographic Service Providers

Navaho Lock with Voice ä accesses the Cryptographic Service Provider (CSP) that is part of the 
Windowsä operating system (starting at Windows 95&TM&, release version 3). Most operating 
systems have the Microsoft Base Cryptographic Service Provider installed. To check your computer to 
see which cryptographic service provider is loaded, open the Address Book and select Add. Any 
installed cryptographic provider will show up in the drop-down menu. If you do not have a CSP 
installed, you can get it by downloading and installing MicrosoftÒ Internet Explorerä version 4.0 or 
higher.
The Base Cryptographic Provider is commonly used for communications outside of North America. The
U.S. has strict laws controlling the export of strong encryption tools and it is quite possible your 
contacts in Europe and Asia will only have access to algorithms of 56 bits or less.    If you are unsure 
make sure you contact the recipient before sending an encrypted package using the enhanced CSP, 
otherwise they may not be able to open the package.
The Microsoft Enhanced CSP contains algorithms of up to 168-bit strength. If the Microsoft Enhanced 
CSP is not loaded on your computer and you are a resident in the United States or Canada you can 
download it by visiting http://www.microsoft.com/windows/ie/download/128bit/intro.htm.
Netscape users wanting to download the high encryption pack can do so by visiting 
http://home.netscape.com/smartupdate/ 



Other CSP's

In addition to Microsoft'sÒ Enhanced Cryptographic Service Provider, several others are available that 
may work with Navaho Lock with Voice ä.



Web-based Email Program

Presently, Navaho Lock with Voiceä does not work fully with Web-based email (e.g., Hotmail or 
Yahoo). You can, however, use Navaho Lock with Voiceä to encrypt your documents locally and then 
send them as attachments.



Installing Navaho Lock with Voice 

Navaho Lock with Voice comes as a self-installing executable file. After downloading the program to 
your hard disk:
1) If using Windows NT, Logon to your computer as Administrator or a user from the Administrator 

group.
2) Double-click the Navaho Lock with Voice application icon to begin installation.
3) When the dialogue box appears on your screen click on Setup and the installation will start 

automatically.
4) Navaho Lock with Voice will prepare the InstallShield Wizard which will guide you through the 

rest of the setup process.
5) Follow the instructions on the screen.



Base Cryptographic Service Provider

If you are using MicrosoftÒ Internet Explorerä version 4 or higher, the Microsoft Base Cryptographic 
Provider will be installed in the Windows operating system.
To find out if you have the Base Cryptographic Provider, open your Address Book and click on Add. 
The dialog box that pops up should list Microsoft Base Cryptographic Provider under the drop-down 
Crypto Service Provider Name. If it isn't listed, you will need to download and install the latest version 
of Microsoft Internet Explorer.
You can get Internet Explorer from the Microsoft Web site at:
http://www.microsoft.com/windows/ie/download/windows.htm 



Enhanced Cryptographic Service Provider

The MicrosoftÒ Enhanced Cryptographic Service Provider contains strong algorithms that are only 
available to residents of North America. The Enhanced Provider should only be used for sending 
messages within Canada and the U.S.
You can download the Microsoft Enhanced CSP from Microsoft's Web site at:
http://www.microsoft.com/windows/ie/download/128bit/intro.htm 
After downloading the file double click to install. The InstallShield Wizard will walk you through the 
installation process.
Netscape users wanting to download the high encryption pack can do so by visiting 
http://home.netscape.com/smartupdate/ 



Change User Settings and Password

You can change your Logon password by logging on and selecting Change Password in the User 
Logon dialog box. Enter and confirm your password. REMEMBER IT!
Use Change Settings in the same location to modify existing data, including the default cryptographic 
service provider and algorithm, your email address, and your phone number.

 
As a security precaution, Navaho Lock with Voice ä will prompt you to enter your existing User Logon 
Password prior to changing your password or other settings. Remember your new password.



Create New User

To create a new user, click on the Logon icon. The User Logon dialog box will appear.

 
Select New User and let the New User Wizard guide you. A valid email address is required for each user 
for Navaho Lock with Voice ä to work properly.



Delete User

You must log off and log on again to delete a user. When you choose Delete User from the Logon 
dialog box, Navaho Lock with Voice ä will warn you that all files and passwords associated with that 
user will be deleted. As a precaution against inadvertently deleting a user and their associated Address
Book, a prompt asks you to enter the product serial number of your copy of the Navaho Lock with 
Voice program. Enter the serial number in the dialog box to proceed.

 



Guest User

You can safely let other Navaho Lock with Voice ä operators use your program. They will not have 
access to any of your Address Books or encrypted files without your Logon password. See Taking 
Navaho Lock   with Voice   ä   on the Road   to set up a guest user.
If the guest leaves their user name on the system after they have completed their session, you can 
delete them.



Logging On

Navaho Lock with Voice ä keeps your files and contacts away from prying eyes by requiring a user to 
Logon to a session.
Select your user name from the list of users and click OK. Enter your password in the password dialog 
box and click OK.

 



Logging Off and Timeouts

The best way to ensure that your messages and files remain secure is to log off your Navaho Lock with
Voice ä session when you have completed your tasks. You can set your program to timeout after a 
period of inactivity by opening the Options under the View menu. The default setting is never, and the 
options are 5 or 10 minutes. After the program times out, you will have to re-enter your password to get
access to your open documents and Address Book.



Multiple-User Support

Navaho Lock with Voice ä supports multiple users. Each user will only have access to their password-
protected Address Book and encrypted documents.
To create a new user, click on the Logon icon. The User Logon dialog box will appear. Select New 
User and let the New User Wizard guide you.
Create New User 



Simultaneous Users

Navaho Lock with Voice ä allows two or more users to have open sessions at the same time. The first 
user needs to log off and allow the other user to log on. Any open documents or unsaved work in the 
first user's session are inaccessible to the second user.



Taking Navaho Lock with Voice ä on the Road

All you need to be able to send and receive encrypted documents from another Navaho Lock with 
Voice ä program is a copy of your Navaho Lock Address Book file and the product serial number that 
you used to register your copy of the program. Your Address Book file, created with a filename 
combining your user ID with a .cya extension (username.cya), is stored in the Navaho Lock with Voice 
folder. Copy it to a disk by choosing Save/Backup from the Address Book Menu.
When you want to use someone else's Navaho Lock with Voice program, establish yourself as a new 
user using the same password as the Address Book file that you saved to disk. After you log on, 
choose Switch Address Book from the Address Book menu. Navigate to the drive that has your disk, 
select your Address Book file and press OK. You may have to enter your Address Book password.
You can then send and receive encrypted messages. 
Log off when your session is finished. If you will no longer be using that Navaho Lock with Voice 
program, you can delete yourself as a user. Begin the Logon process again. At the Logon dialog box, 
select your name and press the Delete User button. A dialog box will appear and ask you to enter your 
product serial number. Even though you are using someone else's Navaho Lock program, you will be 
able to delete your user name.
Remember to retrieve your disk from the drive before leaving.
Create New User 
Delete User 



When to Use High Security Mode

In an environment where other people can see or use your computer, high security mode offers 
additional protection. High security mode will prompt you for your password before performing most 
actions (e.g., opening a file, opening the Address Book, sending, etc.).
If you are called away from your workstation, no one will be able to see or access anything in your 
open Navaho Lock with Voice ä session (other than an open document) without your password.



How to Use High Security Mode

When you log on as a user, you can choose High Security Mode from the user Logon dialog box.
If you are running in normal mode and you want to switch to High Security Mode, simply log off and log
on again to select the High Security Mode from the Logon dialog box.



The Main Screen

This is what the Navaho Lock with Voice ä main screen looks like when the program is open and you 
are working on a message. Click on the various parts of the image below to reveal their functions.

 



 Drop area  

Drag files from the Navaho Explorer view to the Drop area. When you are ready to send or save, the 
files will be automatically compressed and encrypted (see Sending Unencrypted Messages if you want 
to send an unencrypted package).



Edit Toolbar

The buttons on the Edit Toolbar apply formatting to text in the Message Area.

The formatting options include:
Bold – Italic – Underline - Text Color - Left Justify - Center Justify - Right Justify - Bullets



Explorer

The Navaho Explorer window is used to locate files that will be encrypted and sent, to review sent 
Navaho Lock with Voice packages, to select saved packages and to access online support.
To locate files, click on the Explorer tab. Navigate through the directories in the top pane and double-
click on a folder to display its contents in the lower pane. Once you have located the documents, 
folders, or applications you want in the lower pane, you can drag them to the Drop area for 
compression and encryption.

The Support tab connects to online user support from CyPost's Web site. You can also get information 
directly from the CyPost Web site at http://www.cypost.com/navaho/support.html 
The tabs for Saved Packages and Sent Packages display Navaho Lock packages saved and sent 
respectively. Drag open the window to view the time of transmission, size of the file, sender ID and 
phone number, name of the recipient and subject line of the message.



Menus

The menus at the top of the open Navaho Lock with Voice ä program provide access to most of the 
available commands. For a complete list of the functions of each menu, go to Menu Commands.



Message Area

Type or paste anything into this area, then format it using the Edit Toolbar at the top of the Message 
Area. You can send both encrypted and unencrypted text in the same package. Click on the Encrypted 
Message Area tab and enter the text that you want encrypted, then click on the Unencrypted Message 
Area tab to enter the text that you want exposed.

The subject line for all messages is exposed. Make sure that you do not use the subject line for any 
confidential information (e.g., the secret password or your telephone number).

Your entire Navaho Lock with Voice package, including the text message (exposed and unexposed), 
the files in the Drop area and the voice files in the Voice Area, will automatically be compressed and 
encrypted when sent.



Toolbar

The Toolbar has buttons for commonly used functions. Click on a word below the Toolbar to find out 
what that button does.



Voice Area

The Voice Area is where you can record and playback encrypted voice messages.    To record an 
encrypted voice message with Navaho Lock with Voice ä, click on the Plus button in the Voice Area. 
The following dialog box will appear:

 
Under Voice Message name, enter a name for the encrypted voice file in the space provided. This 
filename will appear in the Voice Subject Header section of the Voice Area when you finish recording this 
message.    
Click on the Record button (circle) to begin recording your message. The tab on the status bar will move 
from left to right as you record.

Click on the Stop button (square) to stop recording at any time.
To listen to your message, click the Playback button (triangle) in the middle for playback.
If you wish to re-record the message, click Cancel.
When finished recording, click OK. You will be returned to the Navaho Lock with Voiceä main screen.
When you send your Navaho Lock with Voiceä package, the voice file will automatically be 
compressed and encrypted. If you want to send the voice message unencrypted, you will have to send 
the entire package as an unencrypted transmission.
Sending Unencrypted Messages 
To play an encrypted voice message, select the voice file and click the Playback button (triangle) in the
Voice Area.



The Menus

The following menus are available in Navaho Lock with Voice ä. Click on a file menu below for a list of
commands within that menu.

          

 



File Menu Commands

The File menu offers the following commands:

New Creates a new Navaho Lock with Voice ä 
package

Open Opens an existing Navaho Lock with Voice ä 
received or locally saved package or file

Save Saves an existing, named Navaho Lock with 
Voice file to the same location that it was 
previously saved to

Save As Saves a new Navaho Lock with Voice file to the
location of your choice

Exit Exits the Navaho Lock with Voice application

 



Edit Menu Commands

The Edit menu offers the following commands:

Undo Reverses previous editing operation
Cut Deletes selected data from the Message Area

and moves it to the clipboard
Copy Copies selected data from the document to 

the clipboard
Paste Pastes data from the clipboard into the 

Message Area at the cursor position

 



View Menu Commands

The View menu offers the following commands:

Toolbar Toggles to show or hide the toolbar

Status Bar Toggles to show or hide the status bar

Explorer View Toggles to show or hide the Navaho Explorer
view

Refresh Refreshes the Navaho Explorer view

Options Resets the inactivity time for timeouts from 
the default (never) to either 5 or 10 minutes; 
and make changes to the SMTP setting

 



Address Book Menu Commands

The Address Book menu offers the following commands: 

Open Opens your Address Book. In High Security 
Mode, you will need to re-enter your Password.

Edit Local Secret Code Allows you to edit your contact password for 
saving files locally

Restore from Backup Restores Address Book from backed up 
version. More 

Save/Backup Saves or makes a backup copy of the Address 
Book

Switch Address Book Switches to a different Address Book
Import Contacts Imports selected addresses from a different 

Address Book (from Outlook Express only) 
More 

Import Address Book 
from Outlook

Imports all addresses from a different Address 
Book (from Outlook Express only) More 

 
Address Book Overview 



Voice Menu Commands

The Voice menu offers the following commands:

Play Plays the selected encrypted recording
Stop Stops the playback of a selected encrypted 

recording
Add Message Creates a new encrypted recording. More
Delete Deletes the selected encrypted recording

 
Voice Area 



Actions Menu Commands

The Actions menu offers the following commands:

Logon Logs on to Navaho Lock with Voice ä
Logoff Logs off of a current Navaho Lock with Voice 

session
Encrypt Turns encryption off for the next Navaho Lock 

with Voice package that you send
Cancel Cancels the transfer of a file into the Drop area 
Back Backs you out of directories in the Drop area 
Back to Root Backs you out of nested directories

 



Window Menu Commands

The Window menu offers the following commands:

Cascade Arranges windows in an overlapped fashion
Tile Arranges windows in non-overlapped tiles

 



Help Menu Commands

The Help menu offers the following resources: 

Tip of the Day Reveals the complete inventory of daily tips
Help Topics Offers you an index and a search function to 

find topics within the Help menu
Quick Start Offers access to the Quick Start feature
Get Microsoft 168-bit 
encryption

Allows users to connect for download of 
MicrosoftÒ Enhanced Cryptographic Service 
Provider

Report a bug Submit a bug or glitch to CyPost
About Displays program information, version and 

copyright 

 



Address Book Overview

The Address Book stores your contact names along with their email addresses and passwords. It is 
important to understand that a document associates with its Navaho Lockä password like a key 
relates to its lock. Usually, a locksmith can replace or recreate a lost or damaged key. But a lost 
document password cannot be recreated, retrieved or substituted. Once the password is lost, all files 
stored with that password are essentially "lost".
The Address Book gives users the ability to create, modify and delete contacts. If you make a mistake 
in entering contact information or if you want to change a contact's email address or password, this 
feature proves helpful.
Read through the following sections to see how to use the Address Book and then go to Managing 
Your Address Book for file management strategies that will help you avoid access problems.
Setting Up New Contacts 
Choosing Algorithms 
Choosing a Contact Password 
Choosing a Cryptographic Service Provider 
Deleting Contacts 
Modifying Contacts 
Updating/Backing Up Address Book File 
Restoring from Backup 
Switch Address Book 
Import Addresses 



Setting Up New Contacts

Open the Address Book and click the Add button.

 
Enter the contact information. A valid email address is required for each contact so that Navaho Lock with 
Voice ä can function properly.
Choose a secret code for that contact.
Choose a cryptographic service provider and an algorithm.
Click OK to accept. Navaho Lock with Voiceä will prompt you to save the modifications to your Address 
Book.



Choosing Algorithms

As a general rule, the higher the bit number, the stronger the algorithm. Also some algorithms use 
double or triple encryption (e.g., DESX, Triple-DES). For a complete discussion of algorithms, open the
Support tab in the Explorer window or visit the Navaho Lock with Voice support Web site directly at 
http://www.cypost.com/navaho/support.html.



Choosing a Contact Password

Navaho Lock with Voice ä uses symmetric-key encryption, which relies on the use of the same 
password (secret key) by the sender and the recipient. The same contact password should be used for 
encrypting and decrypting a message. Obviously, you will need to agree on a password with your 
contact. You should decide this in person or over the phone. If you do not believe the phone line is 
secure, use a temporary password that is something you both know and that can be elicited by a hint 
(e.g., "Remember what you said to me in the elevator yesterday that made everyone laugh?").
The Address Book remembers these contact passwords for you. Since you only have to enter the 
password for each contact once, it can be complicated. A strong secret key includes numbers and both
uppercase and lowercase letters.



Choosing a Cryptographic Service Provider

Most operating systems have the MicrosoftÒ Base Cryptographic Service Provider installed. To check 
your computer to see which cryptographic service provider is loaded, open the Address Book and 
select Add. Any installed cryptographic provider will show up in the drop-down menu. If you need to 
download the Base Cryptographic Service Provider, go to Base Cryptographic Service Provider.
The Base Cryptographic Provider should be used for all communications outside of North America. 
The U.S. has strict laws controlling the export of strong encryption tools and it is quite likely that your 
contacts in Europe and Asia will only have access to algorithms of 56 bits or less.
The Microsoft Enhanced CSP contains algorithms of up to 168-bit strength. If the Microsoft Enhanced 
CSP is not loaded on your computer and you are a resident in the United States or Canada, see 
Enhanced Cryptographic Service Provider. Use this CSP for communications within North America 
only.



Deleting Contacts

If you delete a contact, you delete the associated password. 
Any documents on your system that were encrypted with this password will therefore be 
inaccessible.
If you suspect that you may have files on your system encrypted with that contact password, you may 
want to double check the contents of the files before deleting the contact and the associated password.



Modifying Contacts

Modifying a contact can have the same problematic effect as deleting a contact.
If you change a contact's password, any documents encrypted with the old password will be 
inaccessible.
If you change a contact's email address, Navaho Lock with Voice ä will not know which password is 
associated with any new documents received from that person. 
The old contact password and address will open the older associated files, and the new contact 
password and address will open all future Navaho Lock packages.
Managing Your Address Book 



Updating/Backing Up Address Book File

Creating backups is important - especially when you are dealing with encrypted files and passwords. 
When you first set yourself up as a new user, Navaho Lock with Voice ä creates an Address Book with
a filename that includes your user name and a .cya extension (username.cya). This Address Book file 
is stored in the Navaho Lock folder along with any other user's Address Book files. Navaho Lock 
encrypts your Address Book and all backups you make with your default algorithm and your password.
A simple backup strategy involves adding a 4-digit date in the format "mmyy" to the Address Book file 
name (i.e., username1299.cya). This will make it easy to select which backup is the most recent. You 
can also backup to a floppy disk for added security or when you need to use your contacts on 
someone else's copy of Navaho Lock with Voice. 
Taking Navaho Lock   with Voice   ä   on the Road   



Restoring from Backup

If for some reason you have inadvertently deleted a contact or modified a contact and you want to 
retrieve your last saved Address Book, choose Restore from Backup from the Address Book menu. A 
dialog box will open and you can then select your most recent backup. When you select OK, the 
contacts from the backup will overwrite the contacts in your current Address Book.
Any contacts that were in your original Address Book but not in your backup will be lost.
To keep these contacts, import the additional records to the backup Address Book before you perform 
the Restore from Backup. Go to Import Addresses for more.



Switch Address Book

This feature allows you to simultaneously maintain more than one Address Book file and to switch 
between them. If you want to use Navaho Lock with Voice ä at home or on someone else's computer 
while you are on the road, you will need to bring your Address Book file and your password with you.
When you choose Switch Address Book from the Address Book menu, a dialog box opens that allows 
you to navigate to the Address Book you want to use. Select the Address Book file you want to switch 
to and press OK.
Navaho Lock with Voiceä will check the new Address Book against your user name and try your 
existing Logon password. If you have the same password for both Address Books, Navaho Lock with 
Voiceä will switch to the new one. If the new one is from a different user or has a different password, 
the program will prompt you for the correct password for the Address Book you want to switch to.



Import Addresses

The Import functions allow you to bring in contacts from one Address Book to another. This feature is 
useful when you have Address Books in more than one location, when you gather new contacts while 
on the road, or when you are using Navaho Lock with Voice ä on someone else's computer. See 
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To import selected contacts, open Import Contacts under the Address Book menu. Navigate to the 
Address Book file that contains the addresses you wish to import. Open the Address Book using the 
password associated with that Address Book. Choose the address you want to import. To choose more
than one, select the first address and hold down the Control key while selecting the other addresses 
you want to import. When all the addresses you want to import are selected, use the arrows to bring 
them over to the other Address Book and press OK.
To import from an Outlook Express Address Book, choose Import Address Book from Outlook Express 
under the Address Book menu. Select the contacts that you want to import from the list in the left 
window. Use the arrows to bring them over to be imported. Click OK.
You will then be returned to your original Address Book and the new addresses should be there. If 
there are any duplicates, Navaho Lock with Voiceä will ask you if you want to keep the existing ones 
or the new ones.



Managing Your Address Book

Navaho Lock with Voice ä creates a new Address Book file, encrypted with a CSP and algorithm, 
whenever you set up a new user. More
The Address Book file, labeled with a filename that includes your user name and a .cya extension 
(username.cya), is stored in the Navaho Lock folder. As with any computer file, it is a good idea to back
it up occasionally. You may already have a system for backing up files, but one approach is to add the 
date to the filename (i.e., username1299.cya).
As discussed in the Address Book Overview, access to documents can be lost if passwords and 
contacts are not managed properly.



Identifying Navaho Lock with Voice ä Encrypted Files

Navaho Lock with Voice ä encrypted files have a .nvl file extension. Locally filed documents default to 
the Navaho Lock folder in your program files.    Address Book files have a .cya extension. Address 
Books are also stored in the Navaho Lock folder.
Received files are stored within your email program, unless you resave them to the Saved Packages 
folder. More



Viewing Encrypted Attachments

When you open a Navaho Lock with Voice ä package, the attachments are visible in the Drop area. 
You can view the contents of a file by double-clicking the filename. If you have an application that 
opens that kind of document, Navaho Lock with Voice ä will launch the application and open the file.
If the file will not open, you either do not have the appropriate application or Navaho Lock with Voiceä 
cannot open the application. If you think you do have the appropriate application, you can drag the file 
out of the Drop area to another directory and try to open it using the application.
Be aware that once a file is dragged out of Navaho Lock with Voiceä, it is no longer encrypted. 



Retaining Encrypted State

By default, all documents in Navaho Lock with Voice ä retain their encrypted state. You need to drag 
documents out of the Drop area to decrypt them or to save them in an unencrypted state.



File Will Not Open

When you double-click a document in the Drop area, the document will open with the appropriate 
application. If the document does not open, one of the following conditions may apply:
1. You do not have the appropriate application installed for opening this kind of document.
2. You have the application installed, but it is not recognizing the file extension. This can be changed 

in your operating system settings.
3. Navaho Lock with Voice ä cannot launch this particular application.

If you drag the file out of the Drop area into a folder in the Explorer view, you should be able to open it 
if you have the appropriate application.



Saving Outside of Navaho Lock with Voice ä

If you want to save a document in an unencrypted state, simply drag it out of the Drop area into a 
folder in Navaho Explorer, or choose extract and it will be saved in an unencrypted state.



Starting a New Message

After logging on to Navaho Lock with Voice ä, press the New button or choose New from the File 
menu. A new Navaho Lock with Voice package will open - ready for you to record an encrypted voice 
message, type a text message and attach files for encrypting.



Finding and Moving Files for Encryption

The Explorer view to left of the Drop area is where you can navigate through your files to find the ones 
you want to encrypt. Find the directory or folder that contains the file you are looking for and double-
click on it. The contents of the directory or folder will be displayed in the lower window. You can select 
the file you want and drag it to the Drop area for encryption.



Using the Message Area

You can type or paste any text message into the Message Area. The formatting tools below allow you 
to add color, change fonts and appearance, and justify text.

 
Use the tabs at the bottom of the Message Area to enter encrypted text and/or exposed (unencrypted) 
text. Select the Encrypted Message Area tab to enter the portion of your message that you want 
protected. Select the Non-encrypted Text Area tab to enter the text that you want exposed.



Using the Voice Area

You can record, delete or playback a Navaho Lock with Voice ä encrypted voice message using the 
features of the Voice Area.

To record an encrypted voice message with Navaho Lock with Voice, click on the Record button (plus 
sign) in the Voice Area and a dialog box will prepare your message.
To delete an encrypted voice message, select the voice file in the Voice Subject header window and 
click the Delete button (minus sign).
To play an encrypted voice message, select the voice file in the Voice Subject header window and click
the Playback button (triangle). To stop the voice message, simply click the Stop button (square).

When you send a Navaho Lock with Voice package, any attached voice file will automatically be 
compressed and encrypted. If you want to send the voice message unencrypted, you will have to send 
the entire package as an unencrypted transmission.
Sending Unencrypted Messages 



Sending the Encrypted Message

When your Navaho Lock with Voice ä package is ready to send, press the To button in the Message 
Area. The Address Book will open so that you may choose a contact to send the message to. After you 
select a contact and press OK, Navaho Lock with Voice will return you to the main screen.
Press the Send button in the Message Area and your message is sent. More



Sending to Non-Navaho Lock with Voice ä Recipients

You can safely send a Navaho Lock with Voice ä encrypted document to a non-Navaho Lock user. 
When the person receives the email, they will see a message telling them that the email was encrypted
using Navaho Lock with Voiceä and download instructions. 



Save Overview

Pressing the Save button drops down a menu of choices that will be applied to the currently open 
document:

 

Save Saves changes to a previously saved 
package in the same location and with the 
same filename. If you have not previously 
saved a version of the package, the Save As 
dialog box opens.

Save As Opens dialog box to allow user to choose 
name and location for encrypted package

Save to Saved Packages 
Folder

Shortcut to save an encrypted package to 
Saved Packages folder in Navaho Lock with 
Voice ä 

Saving Encrypted Copies of Outgoing Mail 
Saving Encrypted Copies of Incoming Mail 
Saving Unencrypted 
Encrypting Files on your Hard Drive 
Saving before Logging Off 



Saving Encrypted Copies of Outgoing Mail

Navaho Lock with Voiceä automatically saves sent mail in a folder called Sent Packages in the 
Navaho Lock with Voiceä folder. You can view this folder under the Sent Packages tab in the Explorer 
view.



Saving Encrypted Copies of Incoming Mail

Incoming Navaho Lock with Voice ä packages are stored within your email program. You can either 
leave them there or save them to a different location
Choose Save if you have made changes and want to save the package to the same location.
Choose Save As to save the package to a location of your choice.
Choose Save to Saved Packages to save the files to the Saved Packages folder.
After saving an encrypted copy of incoming mail, you can delete the original email and any associated 
attachments.



Saving Unencrypted

You can save any encrypted file attachment in an unencrypted state. Simply drag the file out of the 
Drop area into a directory in the Navaho Explorer view. To save the text message in the Message Area,
copy and paste it into a word processing document and save it in the same directory as the 
attachments.



Encrypting Files on your Hard Drive

Drag the files that you want to encrypt to the Drop area. Press the Save button and select Save, Save 
As, or Save to Saved Packages. 



Saving before Logging Off

If you have minimized messages open in Navaho Lock with Voice ä and you leave your workstation, 
the session may timeout. You will have to log on again to make any changes to these files or to save 
them. If the files are in a saved state, you can simply choose Exit from the File menu to quit the 
application. If you have not saved the file yet, quitting will bring up a Save dialog box. You may need to 
log on again to save the file.
To change the timeout setting, see Logging Off and Timeouts.
If a user leaves files open and unsaved and a second user wants to quit the Navaho Lock with Voiceä 
program for them, they will have to quit the application without saving the most recent changes to the 
files. The second user must say "No" to the query "Do you want to Save changes to …?". Navaho Lock
with Voiceä will quit without saving the most recent changes to the affected documents.



Managing File Overview

Your file management requirements will vary depending on how and where you use the Navaho Lock 
with Voice ä application. 
If you are the only person who uses Navaho Lock with Voiceä on your computer and it is the only 
computer you use it on, file management will not require any special considerations.
If you use Navaho Lock with Voiceä both at work and at home, or have multiple users, it will quickly 
become difficult to know which file belongs to what user unless some organization is done at the 
outset. For multiple users, it is highly advisable to create individual directories for storing each user's 
encrypted files.
Closing Open Files 
Closing Other User's Files 
File Names 
Setting Up User Directories 



Closing Open Files

When you close a Navaho Lock with Voice ä file after viewing it, it automatically returns to its 
encrypted state. You must use Save As under the Save button to store it in an unencrypted state.
If you leave your workstation when you are logged on to Navaho Lock with Voiceä and you are not in 
High Security Mode, any casual passerby can peruse an open file. It is recommended to close files and
logoff when you leave your workstation.
When you quit Navaho Lock with Voiceä, the program will prompt you to save any unsaved 
documents. Saved documents will close without bringing up a dialog box.
Logging Off and Timeouts 



Closing Other User's Files

If another user leaves and fails to close their open files, you can close them by exiting the Navaho Lock
with Voice ä program. If their work has any unsaved changes, the program will prompt the user to log 
back on.
If that person has left the premises, you can choose to quit without saving, or leave the Navaho Lock 
with Voiceä program running until that user returns and can log on again.



File Names

For security purposes, your file naming scheme should mean something to you - but nothing to 
unauthorized individuals. A filename like "passwords.nvl" would more likely be a target of attack than 
"whitewall.nvl".



Setting Up User Directories

You can create directories within the Navaho Lock with Voice ä folder or in a file area of your choice. If
you have a lot of contacts or expect to receive a lot of encrypted mail, creating directories will make 
finding files much easier.
If several people use one Navaho Lock with Voiceä program, it is a good idea to create individual user
directories and any sub-directories necessary to manage the files. Each user can store their encrypted 
files within their own directory.
You might even want to create a text file directory of your encrypted files (add each new file to the 
directory as you receive it and encrypt the directory file under your password).
Encrypted Directory Listing 



Address Book Contact Passwords

Contact passwords and secret keys do not need to be remembered by either party, since the Navaho 
Lock with Voice ä Address Book remembers them for you. Combinations of at least 8 characters 
(longer if you can remember it), including both uppercase and lowercase letters and numbers, will 
provide the strongest protection.
For added security, use one password for files you send to a correspondent and another for files you 
receive from that correspondent.



Directory Padding

Since it is a major undertaking to break an encrypted file, encrypt some unimportant files (e.g., a 
picture of your dog, a long joke, or a Readme file) and place them in your encrypted files directory. 
There's a good chance that anyone trying to break into your files will hack a bogus file - an effort that 
will waste their time and protect your interests.



Encrypted Directory Listing

Once you begin to amass a large quantity of encrypted files, you may have difficulty remembering what
was in any particular file. In this case, make up a directory listing that will remind you of file contents 
without being too specific. Encrypt, name and store that directory file with your other encrypted files.



File Naming

If you name a file "finance.nvl" or "accountinfo.nvl", they will most likely be singled out for attack. 
Instead, make up "pet names" for your files based on something you can easily associate with the 
particular file. Create a file naming convention that means something to you. 
If you have difficulty remembering file contents, create an Encrypted Directory Listing.



Nested Encryption

Cryptanalysts debate whether encrypting and then re-encrypting documents will make the files harder 
to break. In some instances, such as double encryption using the same password, the resulting 
encrypted file can actually be weaker than a file treated with single encryption.
If you want to try re-encrypting an encrypted file, you might try one of these techniques (although we 
do not advocate that either of these tactics will increase security):
1. Place your encrypted file into a folder with several other files and then encrypt the whole folder.
2. Use a different algorithm and password for each subsequent encryption.



Storing Off System

In case of fire or theft, sensitive files or those that cannot be duplicated or resurrected should be stored
in a safe place off your system. It is recommended that you keep a backup copy of your Address Book 
file off the system as well.



User Passwords

Your user password, or Logon password, is the only password you need to remember to access all of 
your encrypted documents, your Address Book, and the passwords for all of your contacts. It is vitally 
important that you remember it, rather than writing it down. A password that is short or easy to guess 
weakens your security.
Smart hackers realize that people tend to use passwords that are easy to remember. Rather than 
trying brute force attacks, they will research their victim's birth date, hometown, high school, pet's 
names, etc., and then try different permutations of these words and numbers.
A strong password contains at least 8 characters (longer if you can remember it), including both 
uppercase and lowercase letters and numbers.
If you forget your password, you will lose access to all of your encrypted documents and you will have 
to set yourself up with a new user identity.
Create New User 



Known Problems

· Some users with Creative sound cards have experienced recordings being cut off when playing 
back a file. 

· Some users can not play back Navaho Lock with Voice messages using Maestro PCI sound 
cards installed in a Toshiba laptop (they can record) 

· Some users cannot send Navaho Lock with Voice packages using a proxy server.    They get the
following message "Unable to connect to the SMTP server <mail.navaholock.com>  Change the 
name of the SMTP server in local settings, just press <Alt+L> or verify your connection with your
ISP!"

· "an unnamed file contained an unexpected object" message occurs after some operations 
causing the user to log off and restart Navaho Lock with Voiceä 

· During installation some users get a Media Move Error preventing the process to complete.      

· The mouse over popup on the icons appears twice, overlaying each other 

· The directory listing does not come up in alphabetic order in the explorer tab. 

· Some Programs will not launch properly when you double-click a file in the Drop area. One of 
these is Adobe Photoshop. Select the Extract button, choose the destination of the folder and 
click OK.    You will now be able to open the Photoshop (.psd) document. 



Online User Support

Online user support is available from the CyPost Web site by selecting the Support tab in the Explorer 
window.
You can also get information directly from the CyPost Web site at:
http://www.cypost.com/navaho/support.html



Contacting CyPost

By Phone: 1 (604) 904-4422
By Fax: 1 (604) 904-4433
Email: support@cypost.com 
Snail Mail: #101-260 West Esplanade

North Vancouver, B.C.
Canada    V7M 3G7



Popup

These popups provide additional information on a topic.



Toolbar

 



Algorithms

The algorithm is the mathematical formula that is used to scramble your data.
Algorithms work by shuffling blocks of data around, much like shuffling a deck of cards.
The "key" determines the sequence of shuffling and allows the data to be "unshuffled" back to its 
original order.
One of the main factors in the strength of the encryption is key size, which is measured in bits. 
Currently, 40-bit and even 56-bit keys are considered to be breakable, but 128-bit keys or higher are 
considered to be unbreakable with today's computers. Algorithms that use double, triple, or quadruple 
encryption will further stymie attempts to crack an encrypted message. These algorithms are used two,
three or four times respectively (with a different key every time) to encrypt each message.
The MicrosoftÒ Enhanced CSP comes with several strong encryption algorithms (up to 168 bits); 
however, current export laws in the U.S. limit messages to Europe and Asia to 56-bit encryption.



New

The New button creates a new document on top of any previous messages you may have open. To 
access previous messages, minimize or close it.



Open

The Open button opens file folders. The default folder, the Navaho Lock folder, contains sub-folders for 
draft, incoming, outgoing, and sent packages.



Save

The Save button saves encrypted messages to a specific location.



Extract

The Extract button opens received Navaho Lock with Voice ä packages and allows you to save the 
files to a location of your choice.



Back

The Back button moves you up one level in the Drop area. To move down one level, double-click on 
the folder you want to access.



Logon

The Logon button will begin a new Navaho Lock with Voice ä session. The correct password must be 
entered for the selected user. After you have successfully logged on, you must click the New button to 
start a new message or the Open button to access a file.



Logoff

The Logoff button will terminate your Navaho Lock with Voice ä session. Even if the program is left 
running, your files and messages are secure.



Cancel

The Cancel button stops the movement of a file into the Drop area.



Help

The Help button gives you access to all the Help topics.



Quick Start

The Quick Start button will guide you through the essential features of the Navaho Lock with Voice ä 
program.



Introduction

Navaho Shredder offers a high level of disk sanitization allowing users to securely delete files and 
documents from any computer or network.  Navaho Shredder has been designed to meet and exceed 
the U.S. Department Of Defense standard (DoD 5220.22-M) for data removal.  The program is 
currently capable of overwriting data stored on disk a total of 9 times, exceeding the DoD standard for 
data removal.

Warning!

If you mistakenly shred the wrong document, depending on the level of shredding you choose, 
you may lose the data permanently.    Do not shred any document unless you are positive you 
will not require it in the future.



Getting Started

To shred a file or folder follow these steps:

1) Launch Navaho Shredder - Click on the Shredder Icon in Navaho Lock with Voice ä.    This will 
launch Navaho Shredder.

2) Select Files to Shred - The Explorer view to the left of the Drop area is where you can navigate 
through your files to find the documents you want to shred. Find the directory or folder that 
contains the file you are looking for and double-click on it. The contents of the directory or folder 
will be displayed in the lower window. You can select the file you want and drag it to the Drop area 
for shredding.

3) Set Shredding Level – Once you have highlighted the files you want to shred (for multiple files 
press the Select All icon), choose the shredding level (1overwrite lowest – 9 overwrites highest).    
The default setting is seven overwrites.

4) Modify List – If you wish to remove files from your list you can do so by right-clicking on the 
item(s) and pressing the Remove button. 

5) Shred – After finalizing the shredding level, click on the Shred button.    



Main Screen

This is what the Navaho Shredder main screen looks like when the program is open and you are in the 
process of shredding a document. Click on the various parts of the image below to reveal their 
functions.

 



Navaho Explorer

The Navaho Explorer window is used to locate files that will be shredded. To locate files, click on the 
Explorer tab. Navigate through the directories in the top pane and double-click on a folder to display its 
contents in the lower pane. Once you have located the documents, folders, or applications you want in 
the lower pane, you can drag them to the Drop area for shredding.



Shredder Toolbar

The Toolbar has buttons for commonly used functions. Click on an icon on the Toolbar to find out what 
that button does.



Shredder Drop area

Drag files or documents you want to shred from Navaho Explorer to the Shredder Drop area. When 
you have selected the shredding level, click on the Shred icon and the files will be automatically 
shredded. 



Mini explorer

Toggles to show or hide Navaho Explorer



Select all

Selects all documents in Drop Area



Shredding Level

Choose security level by designating the number of overwrites during shredding



Add

Adds selected documents to list of files to be shredded



Delete

Deletes selected documents from list of files to be shredded



Open File

Opens selected document in Drop area



Shred

Shreds selected documents



Help

About Navaho Shredder



What's New in this Version?

The successor to Navaho Lock v2.4, CyPost’s Navaho Lock with Voice incorporates all the popular 
features in the original product, and has added the following new ones making this the easiest, most 
user friendly version to be offered to the public to date.  Summary of new major features include:

Ability to send and receive encrypted Voice E-mail - In addition to sending and receiving encrypted 
text based email and email attachments such as documents, spreadsheets, and presentations, Navaho
Lock with Voice enables users to easily create and send completely private voice 
communications across any digital network including the Internet.

Addition of an electronic shredder for securely deleting data from disk - Navaho Shredder offers 
a high level of disk sanitization allowing users to securely delete files and documents from any 
computer or network.  Navaho Shredder has been designed to meet and exceed the U.S. Department 
Of Defense standard (DoD 5220.22-M) for data removal.  The program is currently capable of 
overwriting data stored on disk a total of 9 times, exceeding the DoD standard for data removal.

A new and improved streamlined GUI for even greater ease of use - Though having received 
favorable product reviews from influential industry media such as PC Magazine, PC World Online, 
CNN Interactive, Portable Computing, and Dave Chalk Computer Show, we wanted to further improve 
ease of use and increase user productivity - making Navaho Lock with Voice the easiest, most user 
friendly email security program on the market today. 



Installing Navaho Lock with Voice from CD

Installation instructions:
1) Insert the Navaho Lock with Voice disc into your CD-ROM drive.
2) When the dialogue box appears on your screen click on Setup and the installation will start 

automatically.
3) Follow the instructions on the screen.

If the installation does not start automatically:
1) For Windows 9X or Windows NT click Start on the Taskbar.
2) Click Run.
3) Type d:\setup, where d is the letter of your CD-ROM drive.
4) Click OK.
5) When the dialogue box appears on your screen click on Setup and the installation will start 

automatically.
6) Follow the instructions on the screen.



Navaho Lock with Voice Setup Checklist

Now that you have successfully installed Navaho Lock with Voice, it is important that your microphone 
and speakers are working properly before you start evaluating Navaho Lock with Voice.  This will 
ensure the highest quality of recording and playback of encrypted voice files.

Before using your microphone to begin recording make sure of the following:
The microphone is plugged in completely.
The microphone is plugged into the microphone jack and not the line-in jack.
The on/off or on/mute switch on the microphone is turned on.    
If you have more than one sound card in your computer, the microphone is plugged 
into the correct sound card.

To ensure your external speakers are working properly check the following:
The speaker is plugged into an electrical outlet.
The on/off switch on the speakers is turned on.
The speaker is plugged into the speaker jack on the sound card and not the 
headphone jack of the CD-ROM.
The speaker volume is set at an audible level.
If you have more than one sound card in your computer, the speaker is plugged 
into the correct sound card.
The sound card you are using has been tested for use with Navaho Lock with 
Voice.

To ensure your internal speakers are working properly check the following:
There is nothing plugged into the speaker jack of the sound card.
There is no conflicting software installed on your system that has disabled the 
speaker.
Your computer is capable of playing sound files via the internal speaker.    Some 
older computers have internal speakers that can produce sounds, but are not able
to play sound files.    Check the computer manual if you are unsure of the status of
your internal speaker.

Once you have checked that your microphone and speakers are plugged into the proper jacks, you 
need to ensure your existing audio setup is correct. 

To ensure Play Control settings on your computer are correct:
Double-click the Volume icon in the system tray (located to the right of the 
Taskbar).
Click Options and select Properties.
Select Playback and make sure the Play Control and Wave/DirectSound/MP3 
volume control boxes are checked off; click OK.
On the Play Control screen make sure Play Control and Wave/DirectSound/MP3 
boxes have not been muted.
Click Options again and select Advanced Controls.    Click Advanced in the 
Advanced Controls for Play Control column and ensure the Digital Output Only 



box has not been checked off.

To ensure Record Control settings on your computer are correct:
Double-click the Volume icon in the system tray (located to the right of the 
Taskbar).
Click Options and select Properties.
Select Recording and make sure the Microphone volume control box is checked 
off; click OK.
On the Record Control screen make sure the Microphone box has been checked 
off.
Click Options again and select Advanced Controls.    Click Advanced in the 
Microphone column of the Record Control screen and ensure the Mic Boost 
(20dB) box has been checked off.

You are now ready to use Navaho Lock with Voice!



 {ewl RoboEx32.dll, WinHelp2000, }




